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1. Radio wave transmission utilizes different types of propagation.
» Two
» Three
» Four

> Five

2. Analog refers to something that is continuous in
» Time
» Space
» Frequency
> None of the given

3. Asine wave is .
» Periodic and discrete
» Aperiodic and discrete
» Periodic and continuous
» Aperiodic and continuous

4. In frequency shift keying, remain(s) constant.
» Frequency
» Amplitude
» Both Amplitude and Phase

» Both Phase and Frequency

5. Quantization is a method of assigning values in a specific range to
sampled instances.
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> Negative
> Positive
> Binary

> Integral

6. Ethernet Address is of----------------- bytes
> 4
> 6

> 8

> 12

7. In , a station monitors the medium after it sends a frame to see if

the transmission was successful.

» CSMA

> None of Given
> CSMA/CA

8. POTS stand for ?

» Plain Old Telephone System
» Plain Old Telephone Services

9. Like Data link layer, is also responsible for Flow control.

» Transport Layer
» Session Layer

10. What was the main draw back in ALOHA Random-Access method?
» Redundancy in Data
» Potential Collision
» Inconsistent Data rate

» All of the given

11. DB is negative if a signal is
» Attenuated
» Distorted
»  Amplified
> Noisy

12. Central Hub in a Tree is an
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> Active hub
> Passive hub

13. At the Application layer, object/information is in the form of
» Message
» Packet
» Segment
» Frame

14. uses fiber-optic cable
» 10base-F

15. The transmission medium that carries the message is referred to as the

» Send and receive device

» Communication channel
» Protocol

» Gateways

16. Latency is made of components.
» Two
» Three
» Four
> Five

17. Analog to Analog Conversion Methods include
AM, PM and FM

AM, FSK and PM

AM, PM and QAM

None of the given

YV V VY

18. is the rate of change with respect to time.
Voltage

Time

Frequency

Amplitude

Y V.V V

19. The Internet is :
» Software for sending e-mail around the world
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» A government-owned agency that links computers
» A global network of computers networks
» aspecialized form of local area network

20. Signals travels through fiber optic cable are in the form of
Light

Bits

Electromagnetic

Bytes

YV V VY

21. In encoding, we use three levels: positive, zero, and negative.
» Polar
» Nonpolar
» multilevel
> Bipolar

22. A periodic signal completes one cycle in 0.001 s. What is the frequency?
» 1Hz
» 100 Hz
» 1KHz

23. Zero crossing bandwidth is also called as equivalent noise bandwidth.
» True

> False

24, was used as the medium in 10 Base-T.
» Twisted Cable
» Thick Coaxial Cable
» Thin Coaxial Cable

25. One of the most common protocols for point-to-point access is

> PPP
> 1P

26. Encoding digital data into digital signals is called
» Analog-to-Digital Conversion
» Digital-to-Digital Conversion
» Digital-to-Analog Conversion
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> None of the given

27. Digitizing an Analog Signal is called
» Analog-to-Digital Conversion
» Digital-to-Digital Conversion
» Digital-to-Analog Conversion
» None of the given
28. Low pass channel has bandwidth between two stations.
» Dedicated
» Shared
» Multiplexed
> Infinite

29. What is the period of a Sine wave having frequency of 2 Hz?
> 0.2
> 0.1
» 05
> 0.3

30. A broadcast signal is received by the orbiting satellites which rebroadcasts

» To the resender
» To the sender
» To the atmosphere

» None of the given

31. Normally the value of Kmax in pure ALOHA is
25
10
15
30

VYV VY

32. of a signal is the collection of all the component frequencies it contains.
Time domain

Frequency domain

Frequency spectrum

None of the given

VYV VY

33. In which controlled-access method all data exchanges must be made through

Sparrow +923313000225




CS601

primary device even when the ultimate destination is a secondary device?
» Polling
» Reservation
» Token Passing
» Port Forwarding

34, is correct formula to determine the total number of ports needed for one
system connected in a mesh network.
» N+1
» N-1
> N (N+1)
» NxN

35. The flag in PPP is a byte that needs to be whenever it appears in the data
section of the frame.
» Duplicated
> Blocked
» Cleaned

» Escaped

36. To control and manage the transfer of data, a protocol called Point to Point Protocol
(PPP) is used at the layer.
» Physical
> Network
» Presentation
» Data link

37. What is the Bandwidth of a periodic signal if it is decomposed into 4 sine waves with
frequencies 200, 400, 600 and 8007
> 100
> 500
> 300

» 600

38. In selective-reject ARQ, only the specific damaged or lost frame is
» Retransmitted
» Forwarded
» Selected
» Rejected
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39. Two or more computers connected so that they can communicate with each other
and share information is called a
> Satellite
» Protocol
» Broadcast
» Network
40. If the Hamming distance between sent and received code word is , then it
shows that received data is corrupted.
> #0
> =0
> #1
> =1

41. Congestion Control is a feature of layer(s).
» Data Link
» Network
» Transport
» All mentioned

42. Which of the following consist of just one redundant bit per data unit?
» Two dimensional Parity check
» CRC
» Simple Parity Check
» Checksum

43. A property of a signal where it is being received by receiver after reflection from
different intermediate objects (Building, iron polls, walls) is called

Attenuation

Interference

Error

Multipath Propagation

YV V VY

44, Medium is used in wireless LANs for transportation of data.
Copper pair cable

Optical fiber cable

Coaxial cable

Air

Y V.V V
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45. Checksum is an error-detection technique that can be applied to a message of
length.
> Exactly 4
> Exactly 8
» Exactly 32

» Any
46. The extra bits added with the original data for error detection/correction are called

» Fault bits

» Port numbers

» Redundant bits
» Process IDs

47. A fiber -optic cable transmit signals in the form of
» Light
» Sound
» Wave
» None of the given

48. In CSMAJ/CA, is the amount of time divided into slots.
» Interframe Window
> Contention Window
» Fragmented Window
» Collided Window

49. In circuit switched networks we have low efficiency but minimal
» Delay
» Speed
» Throughput
» Errors

50. The level of signal is always positive in NRZ encoding.
» True

> False

51. WDM stands for .
» Wave Division Multiplexing
» Worong Division Multiplexing
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» Well Division Multiplexing
» West Division Multiplexing

52. Asynchronous transmission is
> Slow
> Fast
» Costly
> None effective

53. Data is transmitted using light through a cable.
» Twisted pair
> Fiber-optic
» Coaxial
» Microwave

54. STP is more expensive than UTP and is less susceptible to noise.
» True
> False

55. PSK is susceptible to the noise degradation.
» True

> False

56. CDMA stands for :
Carrier Division Multiple Access

>
» Carrier Data Multiple Access
» Code Data Multiple Access
» Code Division Multiple Access
57. is not a function of Data Link Control.
» Framing
» Modulation
» Error Control
» Flow Control

58. Time domain plot show changes in signal phase with respect to time.
» True

> False
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62.

59. Which of the following is not a characteristic of a sine wave?

» Amplitude

» Segmentation
> Phase

» Frequency

60. In TCP/IP protocol suite, the process of adding header at each layer on sending side
is known as

» Encapsulation
De-encapsulation
Packetizing
Framing

YV V

61. Asynchronous TDM is efficient only when the size of the time slot is kept relatively

Large
Small
Medium
Zero
Signal can take infinite levels of intensity over time.
Digital
Discrete
Analog
Logical

YV V VY

VYV VY

63. DLC in Data Link Layer stands for

» Divide Line Communication
» Data Line Code

» Data Link Control

» Demand Link Coordination

64. In IEEE 802.11, a station with mobility can move from one BSS to
another, but the movement is confined inside one ESS.

» None of the choices are correct
» No-transition

» ESS-transition

» BSS-transition

65. In IEEE 802.11, communication between two stations in two different BSSs usually
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occurs via two

>
>
>

>

BSSs

ESSs

None of the given
Aps

66. The logical connection between the peer layers is connection.

YV VYV VY

67.

YV VYV

Physical
Direct
Indirect
Tangible

encoding is almost obsolete today
Bipolar
Unipolar
Polar
None of the given

68. PAP and CHAP are used by __ as Authentication Protocols.

>

PPP

69. Which one of the following is not a Channelization Protocol?

>
>
>
>

70. In Block coding scheme, number of code words is always data words.

>

VYV V V

71.In

VYV VYV

FDMA
CSMA
CDMA
TDMA

Less than
Equal to
Greater than
Same as

, each station is allocated a time slot during which it can send data.
CDMA

NDMA

TDMA
FDMA
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72. The message 1110 sent by a source is received by a destination as 1011. This is
type of error.
» Burst
» Single-Bit
» Uni-Bit
» Hamming

73. The most common type of connector used by coaxial cable is
BNC
RJ-45
RJ-11
RJ-57

YV V VY

74. Each computer on the Internet has a unique numeric address called a(n)

» domain address
» protocol address
» |IP address
» Web address

75. The inversion of the level at 1 bit is called as
» NRZ-L
» NRZ-I
> RZ
> None of the given.

76. is an Authentication Protocol, which uses two-step process to authenticate
user information.
» CHAP
> LCP
> PAP
> ICMP

77. ALOHA the earliest random access method was developed in early
> 1950s
> 1960s
> 1980s

» 1970s
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78. The amplitude of a digital signal depends upon the to represent a bit.

>
>
>

>

Phase
Wavelength

Bandwidth
Voltage

79. Which error detection method uses one's complement arithmetic?

>
>

>
>

Cyclic Redundancy Check (CRC)
Longitudinal Red Check (LRC)
Checksum

Simple Parity Check

80. Quadrature Amplitude Modulation (QAM) is the combination of and

>
>
>
>

FSK, PSK
PSK, FSK
ASK, PSK
ASK, FSK

81. Which of the following statement is correct?

YV V VY

82.

YV VYV

83. The

Y V V VYV

Digital signals are less prone to Noise
Digital signals are highly prone to Noise
Analog Signals are less prone to Noise
Digital signals are not affected by Noise

is normally used where speed is priority in data transfer.
Serial data transmission
Hybrid data transmission
Parallel data transmission
Both parallel and serial data transmission

protocol uses both flow and error control.

TCP/IP

HDLC
ICMP

Stop-and-Wait

84. Switch is a network device which operates on the layer of the TCP/IP
protocol suite.
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» Application
» Transport

» Presentation
» Data link

85. If a digital signal has ""L" number of levels. IS the number of bits required
to represent each level.
> LogL
» Log Base 2 L
» L Square
» Log(2*L)

86. In an analog hierarchy to carry voice channels, a group can carry voice
channels.
> 60
> 12
» 20
> 10

87. is an Authentication Protocol, which is used by the PPP to authenticate
passwords.
» CHAP
> PAP
» LCP
> ICMP

88. Primary device uses to receive transmission from the secondary
devices.
» ACK
> ENQ
» POLL

89. Token Bus has no commercial application in data communications
» True
> False

90. Which one is not the function of data link layer?
» Line discipline
» Flow control
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> Error control
> Network control

91. In CRC there is no error if the remainder at the receiver is
» Equal to the remainder at the sender
» Zero
» Nonzero
» The quotient at the sender

92. In ASK, Noise usually affects the
» Amplitude
» Phase
» Sample
» Frequency

93. Sampling means measuring of signal at equal intervals

» Amplitudes
» Frequencies
» Phases
> None of the given
94. Data Link layer provides services to the layer.
» Application
» Transport
> Network
» Session

95. BSC supports transmission using
» Full-duplex, Stop and wait ARQ
» Half-duplex, Selective reject ARQ
» Full-duplex, Selective reject ARQ

» Half-duplex, Stop and wait ARQ

flow control.

96. In each band is reserved for a specific station, and it belongs to the station

all the time.
» FDMA
> CDMA
> TDMA
» CSMA
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97. TROPOSHERE is the layer of atmosphere above the troposphere but below space

>
>

True
False

98. The inversion of the level represents a 1 bit in encoding

YV V VY

99.

NRZ-I
NRZ-L

RZ
Manchester

Works with topologies in which one device is designated as a primary

station and the other devices are secondary stations.

>

YV V VY

100.

YV V VY

101.

YV V VY

102.

low resolution section in the first packet is

>
>
>

103.

Reservation
Polling

Token

None of the given

The original Ethernet technology with the data rate of 10 Mbps is called
?

Standard Ethernet

Fast Ethernet

Gigabit Ethernet

10 Gigabit Ethernet

In , each station sends a frame whenever it has a frame to send.
Slotted ALOHA

Fragmented ALOHA

Pure ALOHA

None of the given

In a technique called, compounding High-and-Low Resolution Packets, the

CRC
Parity code
Empty

In line discipline the initiator first transmits a frame called an
Enquiry
Acknowledgment
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» NAK
» Request

104. To make sure that source does not overwhelm destination by sending data
faster than it can be handled and processed is called?
» Addressing & Routing
» Exchange Management
» Flow Control
» Recovery

105. are used to exchange session management and control information
between connected devices.
> |-frames
U-frames
S-frames
N-frames

YV V V

106. Time division multiplexing is used in systems.
Analog

Hybrid

Digital

Automated

VYV VY

107. What is the frequency of a sine wave if it completes one cycle in 5 seconds?
0.5
0.6
0.3

0.2

Y V.V V

108. Which of the following is most affected by noise?
PSK

ASK

FSK

QAM

YV VV V

1009. is sometimes called the bit rate.
Signal rate
Modulation rate

Data rate

Y VY

A\
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>
110.
>
>
>
>
111.
see
>
>
>
>
112.

overlapping of frequency bands assigned to each user.

Y V.V V

113.

from1toOor fromOtol.

VYV VY

114.

error is this?

YV V VY

115.

YV VY

Pulse rate

Radio is an example of signal conversion.
Analog to analog

Analog to digital

Digital to Digital

Digital to analog

In order to find the location of two errors in an eight bit stream, we have to
different combinations.

28

16

8

4

Guard bands are used in multiplexing technique, to avoid

PDM
CSMA
TDM
FDM

The term means that only one bit of a given data unit is changed

Packet Error
Burst Error
Single Bit Error
Character Error

If the ASCII character H is sent and the character | is received, what type of

Single-bit
Multiple-bit
Burst
Recoverable

Error control in the data link layer is based on
Automatic repeat request
Automatic repeat acknowledgment
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116.

YV VYV

117.

Y VY

118.

YV V VY

119.

Y VYV V

120.

to send

>
>
>

>

121.

Automatic send acknowledgment

Time domain shows changes in
time w.r.t signal amplitude
signal amplitude w.r.t time
time

All of the given

Baud rate is greater than or equal to the bit rate.
True

False

YMODEM has Byte of data unit.
1024

256

128

512

Like 10 Base 5, 10 Base 2 is a topology LAN.
Ring

Mesh

Star

Bus

For FEC using XOR operation, we divide a packet into N chunks, and need
Chunks to the receiver side.

N

2N

(N+1)/2

N+1

At the CRC generator, added to the data unit after the division

process

Y V.V V

122.

Os are
1s are
The polynomial

The CRC remainder is

The flag in PPP is a byte that needs to be whenever it appears in
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the data section of the frame.

>

>
>
>

123.

Duplicated
Blocked
Cleaned

Escaped

In each character protocol each character of frame is encoded using

coding system.

>

124,

Bit-oriented

Mr. Asif while sitting in Lahore is talking with his friend in Dubai through

Skype is an example of

>

YV V V

125.

YV VYV

126.

Local Area Network
Metropolitan Area Network
Wide Area Network

Home Based Network

In , asignal is directed straight from antenna to antenna.
Line of sight propagation

Ground propagation

Space propagation

Tropospheric propagation

No matter whether the link is dedicated or broadcast, data link control

(DLC) layer provides services between

>

YV V VYV

127.

Virtual LANs

Two adjacent nodes
Ethernet links
Source and destination PCs

Multiplexing is the set of techniques that allows simultaneous TX of multiple

signals across data link

YV V VY

128.

Single

Multi

Single and Multi
None of the given

Need for Addressing makes Asynchronous TDM inefficient for bit or byte
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Interleaving
Addition
Subtraction

None of the given

YV VYV

129. The logical connection between the peer layers is connection.
Physical

Direct

Indirect

Tangible

YV VYV

130. Traditionally MANs have been implemented using one of the 2 technologies,
Circuit Switching and Packet Switching
» True
> False

131. IN MAC the generates the data and passes it along with any
control information to a

DTE, DCE

DCE, DTE

DTE, DTE

DCE, DCE

YV V VY

132. What is the vied for a specific saved for a specific frequency of 5 Hz?
0.2
0.1
0.5
0.3

YV V VY

133. Error correction is more than the error detection.
Easy

Useless

Informal

Difficult

Y V.V V

134. A modem is used to connect two DTEs directly.
'NULL

Cable

DSL

V V VY
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> None of the given

135. Analog signals are refers to be
Continuous

Discrete

Periodic

Aperiodic

YV V VY

136. What is the period of a Sine wave having frequency of 10 Hz?
0.2
0.1
0.5
0.3

YV V V

137. There are basic categories of multiplexing.
2

YV V VYV

3
7
5

138. At the CRC generator, added to the data unit before the
divisional process.

Os are

1s are

A polynomial is

A CRC remainder is

YV V VY

139. MAC stand for
Media Access Controller
Main Access Control
Mandatory Access Control

Media Access Control

Y V V VY

140. The VLF and LF bands use propagation for communications.
Ground

Sky

Line of sight

Space

YVVV V
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141.

142.

143.

144.

145.

146.

147.

Y V.V VY YV VY

Y VY

Y V.V V YV V V YV V V

VV VYV

Line Configuration refers to the way two or more devices attach to a

Path
Circuit
Link
Router

POST stand for ?
Plain Old Telephone Set

Plain Old Time Sharing

Plain Old Telephone System
Plain Old Telephone Service

If users must take turns using the link, then it is called Spatial Sharing.
True

False

Possession of TOKEN gives the station the right to
Modify the data

Send the data

Delete the data

Receive the data

There are types of guided media.
2

3

4

5

Aloha, CSMA/CD and CSMA/CA are part of
Controlled Access protocol

Channelization protocol

Mutual access protocol

Random Access protocol

The maximum data rate in the uploading direction is still

26.6 Kbps
33.6 Kbps
36.6 Kbps
46.6 Kbps
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148.

149.

150.

151.

152.

153.

By using system, change in the file contents during file
transmission can be avoided.

Routing

Flow Control

Error Detection and Correction

Congestion Control

YVV VY

Which one of the following is a correct-access method?
Polling

Token Passing

Reservation

All of the given

YVV VY

There are types of serial transmission.
3

4

2

None of the given

VV VY

is the process of converting digital data to digital signals.
CSMA/CD
CSMA/CA
Line coding
Segmentation

VYV VY

In ASK both and remain constant.
Amplitude, Frequency

Amplitude, phase

Frequency, Phase

Amplitude, Samples

VYV VY

and error control, but communication is one frame at a time.
» Simple
» Go-Back-N
» Selective-Repeat
» Stop-and-Wait

At the data-link layer, protocol is designed to handle both flow

Sparro
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154.

The PPP protocol uses , which is responsible for

establishing, maintaining, configuring, and terminating links.

YV V.V VY

155.

YVV VY

156.

Internet Protocol Control Protocol (IPCP)
Challenge Handshake Authentication Protocol (CHAP)
Network Control Protocols (NCPs)

Link Control Protocol (LCP)

Flow control is needed to prevent
Bit errors

Overflow of the sender buffer
Overflow of the receiver buffer
Collision between sender and receiver

GO-BACK-N protocol is one of the layer protocols, which is used

to control the flow of data during the transmission.

>

YV V VY

157.

YV V VYV

158.

Physical
Network
Presentation
Data link

Which one of the following is a Random-Access protocol?
TDMA

CDMA/CD

ALOHA

CDMAJ/CA

What is the Bandwidth of a periodic signal if it is decomposed into 4 sine

waves with frequencies 300, 600, 900 and 1200?

>

Y V V

159.

Y V.V V

100
900
300
600

relatively measures the strength of two signals.
Signal rate
Bit rate
Decibel

Pulse Rate
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160.

>

YV V VY

161.

YVV VY

162.

>
>
>
>

163.

>
>
>
>
164.
>
>
>
>
165.
>
>
>
>

If duration of noise is decreased during a transmission over noisy channel,

fixed data rate of the channel will cause number of bits being impacted by
the noise.

Constant
More
Less
Zero

is responsible for governing node to node communication.
Application Layer
Session Layer
Data Link layer
Presentation Layer

If the window size is 63 in go-back N ARQ then what is the range of sequence

number?

0to 63
0to 64
1to 63
1to 64

Which layer is concerned with the syntax and semantics of info exchange

between two systems?

Physical
Application
Session
Presentation

In Pulse Code Modulation (PCM), the sampling is dependent on
Time

Amplitude

Frequency

Signal Rate

Human voice is example of signal.
Digital

Analog

Discrete

None of the given
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166.

YV VYV

167.

YV V V VY

168.

ring.

YV V VY

169.

VV VY

170.
a restriction on the

VYV VY

171.

YV VY

172.

The IS the number of signal elements sent per unit time.
Data rate

Signal rate

Bit rate

Period

VCI address is address in virtual circuit approach.
Private

Variable

Local

Global

In the method, the stations in a network are organized in a logical

Token-passing
Polling
Reservation

None of the given

Category of coaxial cable is used for Cable TV.
RG-58
RG-59
RG-11
RG-47

For Carrier Sense Multiple Access/Collision Detection (CSMA/CD) we need

Collision Size
Signal Size
Frame Size
Station Size

In Y-MODEM Multiple files can be sent simultaneously
True
False

Error detection and correction are the services provided by layer.
Data link layer
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>
>
173.
than
>
>
>
>
174.
>
>
>
>
175.
>
>
176.
>
>
>
>
177.

VYV VY

178.

Application layer
Physical layer
Session layer

In statistical time division multiplexing, numbers of slots in frame are less

Output data rate

Input lines
Input frequency
Multiplexed T lines

Transmission Control Protocol is a(n) layer protocol.
Transport

Application

Session

Network

Is there any difference between Data communication and telecommunication

are network?

Yes
No

In Block coding we divide our message into blocks of k bits called as

Code words

Data words
Passwords
Cross words

Transmission technology (based on Ethernet) provides a data rate

of 1 billion bits per second.

Fast Ethernet
Standard Ethernet
Gigabit Ethernet
10BASE-T Ethernet

In line discipline after the data transmission, the sending system finishes with
frame.

EOT
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» EKT
> ENT
ESP

Y

179. In ASK correct formula for calculating the bandwidth ia as
B=(1+d)S

B=(1*d)S

B=(d-1)S

B=(d-5)S

YV V VY

180. In OSI model headers are added at layer
1,2,3 only

6,5,7 only

5,4,3 only

6,5,4,3,2 only

Y V.V V

181. is/are un-reliable protocol(s).
IP and TCP

UDP

IP and UDP

TCP

YV VV V

182. WDM stands for :
Wideband De-Modulation

Worst Data Manipulation
Wavelength Division Multiplexing
None of the given

VV VY

183. Need for Addressing makes Asynchronous TDM inefficient for bit or byte

Interleaving
Addition
Subtraction

None of the given

YVV VYV

184. takes data from one high speed line and breaks it into portions.
Multiplexing

Inverse multiplexing

Inverse subtraction

V V VY
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> Inverse addition

185. A sine wave is defined by characteristics.
2

YV VYV

3
4
5

186. CHAP is an Authentication Protocol, which uses process to
authenticate user information.
» Two-way
Three-way
Four-way
Five-way

YV V VY

187. Which error detection method consists of a parity bit for each unit as well as
an entire data unit of parity bits?
» Checksum
» Cyclic Redundancy Check (CRC)
» Longitudinal Red Check (LRC)
» Vertical Redundancy Check (VRC)
188. A portion of the path that carries TX between a given pair of devices is
known as
Direct Point
Bridge
Channel
Access Point

VV VY

189. SONET stands for
synchronous optical network
synchronous operational network
stream optical network

shell operational network

YV V VY

190. Fast Ethernet has a data rate of Mbps.
10

100

1000

10,000

YV VYV V
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191.

Multiplexing is the set of techniques that allows simultaneous TX of multiple

signals across data link

YV V VY

192.
Zero.

Y V.V V

193.

YV V VY

194.
time.

VYV VY

195.

Single

Multi

Single and Multi
none of the given

In the encoding where positive to negative transition is one and vice versa is

Manchester
Differential Manchester
All of the given

None of given

Following characteristics fully describe ,
Amplitude Period/Frequency Phase

Sine Waves

Digital Signals

Aperiodic Signals

None of the given

In Pure ALOHA, the vulnerable time is the frame transmission

Same as
Three times
Two times
Four times

Which level of the TCP/IP reference model routes data/information across a

network channel?

Y V.V V

196.

YV VY

Application Layer
Data Link Layer
Transport Layer

Network Layer

In analog transmission, the base signal is called the

Carrier Signal
Analog signal
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» Digital signal
» Modulated signal

197. In , both peak amplitude and frequency remains constant as the
phase changes.

PSK

QAM

Both PSK & QAM

None of the given

YV V VY

198. Terminal, microprocessor, computer, printer or any other device that
generates or consumes digital data is known as
> DCE
DTE
DCE & DTE
None of the given

YV V VY

199. Digital signals are referred to be
Continuous

Discrete

All of the given

None of the given

YV V VYV

200. In a dedicated communication path is established between two
stations through the nodes of the network
» Circuit switching
> Packet switching

201. Circuit-switched networks have efficiency but delay
compared to the packet switched networks.
» high, minimal
> high, high
> low, minimal

202. Category 5 UTP cable is used for data transmission of upto
100 Mbps

200 Mbps

250 Mbps

400 Mbps

YV V VY
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203. All of popular Fiber optic connectors are shaped.
Conical

Barrel

Circular

Rectangular

YV VYV

204. AM signal requires the BW of original signal
Twice

Half

Same

Three Times

YV V VY

205. S-frames in High-Level Data Link Control (HDLC) are only used to transfer
information.

User data

Control

Redundant

Original

206. Collisions in CSMA/CA are avoided through

The Interframe Space

The Contention Window

Acknowledgements

All of the given

YV V VYV

Y V.V V

207. In even parity check code, the value of syndrome is if the number
of 1s is even.
1

VYV VY

2
0
4
208. If we need to correct a single error in an 8-bit data unit, we need to consider

possible error locations.
16

vV VYV V
o AN
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2009. is used in the Stop-and-Wait protocol to overcome the issue of

duplication.

Frame sequencing
Acknowledgement numbering
Counter and Timer reset

Frame sequencing and Acknowledgement numbering

YV V.V VY

210. Category of coaxial cable is used for thin Ethernet.
RG-58

RG-59

RG-1

RG-47

YV V VY

211. contains a repeater.
Active hub
Passive hub

Y VY

212. IN MAC, when nodes use a multi-point or broadcast link, we need a
to coordinate access to the link.
» Multiple-access protocol

213. Session layer is responsible for
» Reassembly of data

» Maintaining the connection

214, Which of the following is an example of ITU-T modem standards:?
T-series
X-series
N-series
V-series

YV V VY

215. The data rate of a T-1 line is
1.544 Gbps
2.544 Mbps
1.544 Kbps

1.544 Mbps

Y V V V
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216.
correctly describes these three?

217.

218.

219.

220.

221.

222.

YV VYV YV V V VY Y V.V Y

Y V

YV V VY

Y V V V

Y

There are three types of Hubs that exist. Which of the following options

Passive, dormant, special
Active, dormant , passive
Passive, Active, Turbo

Passive, Active, Intelligent

What is the frequency of a sine wave if it completes one cycle in 2 seconds?
0.5
0.6
0.3
0.2

To calculate the data rate for noisy channel formula is used.
Shannon

Nyquist

Propagation

Greedy

In Synchronous TDM, Time slots are not same in number as input devices.
True

False
The type of ALOHA which improves the efficiency of Pure ALOHA is

Slotted ALOHA
Upper ALOHA
Integrated ALOHA
Lower ALOHA

At the CRC checker, means that the data unit is damaged.
A string of Os

A string of 1s

A string of alternating 1s and 0s

A nonzero remainder

RZ stands for
Returnto Z
Retire a Zero
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223.

224,

» Return to Zero
None of the given

Y

Mode of serial transmission guarantees fixed rate of data.
Synchronous
Asynchronous
Isochronous
Metasochronous

YV VY

In Pure ALOHA, the vulnerable time is the frame transmission

time.

225.

226.

227.

228.

» Same as
Two times
Three times
Four times

YV V VY

We can have different groups with a 4 bit block.
4

8

16

32

YV VV V

Which of the following sublayer resolves the contention for the shared
media?

MAC

LLC

Physical

None of the given.

YV V VY

Synchronous transmissions have
A start bit

A stop bit

Gaps between bytes

None of the given

Y V.V V

Using encoding scheme in digital transmission, we represent 0
by zero voltage level and represent 1 by any positive voltage level.

> Polar

> AMI
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Bipolar
Unipolar

Y VY

229. was used as a medium in 10 Base-T
Thick coaxial Cable

Think coaxial Cable

Twisted Pair Cable

Two Modes For Cable

YV VY

230. When data are transmitted from device A to device B, the header from A’s
layer 4 is read by B’s layer.
» Physical
» Transport
» Application

Contact for Help.

We have checked all the Answers if you find any
mistake let us know.

Sparrow +923313000225.
Remember in Prayers.

Best Of Luck.
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